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1 Introduction

The nRF Sniffer is a tool for debugging Bluetooth low energy (BLE) applications by detecting packets
between a selected device and the device it is communicating with, even when the link is encrypted. When
developing a BLE product, knowing what happens over-the-air between devices can help you isolate and
solve any potential issues.

By default, the Sniffer lists nearby BLE devices that are advertising, providing the Bluetooth Address and
Address type, complete or shortened name, and RSSI.

1.1  Required hardware
To set up the Sniffer you will need one of the following kits:

« nRF51 Development Kit (PCA10028) v1.0 or later and a micro USB cable
« nRF51 Dongle (PCA10031)
+ NRF52 Development Kit (PCA10040) and a micro USB cable

1.2 Required software

+ nRF Sniffer software v2.x or later available on the Sniffer product page under the downloads
tab
« Wireshark v2.4.2 or later available from http://www.wireshark.org/.
Wireshark is a free software tool that captures wireless traffic and reproduces it in a readable
format.
+ An operating system that runs Wireshark v2.4.2 or later
« Windows 7 or later
+ 64 bit OS X 10.6 or later
« Linux (check for version compatibility)
« SEGGER J-Link v6.16¢ (which comes bundled with the nRF Sniffer v2.x software)
available from https://www.segger.com

Note: Versions of the Segger J-Link that are newer than v6.16c will not work with the nRF Sniffer
software.

« python v2.7.x available from https://www.python.org/downloads/
« pyserial v3.4 or later available from https://github.com/pyserial/pyserial

1.3  Writing conventions

This user guide follows a set of typographic rules that makes the document consistent and easy to read. The
following writing conventions are used:

- Commands are written in Lucida ConsoTe.

« Pin names are written in Consolas.

« File names and User Interface components are written in bold.
« Internal cross references are italicized and written in semi-bold.
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Setting up the nRF Sniffer

Set up the Sniffer for the first time by performing the following steps:

1.

Install the software listed in Section 1.2 “Required software” on page 2 before plugging in the
hardware.

2. Connect the hardware to a USB port.
3. For Windows - Wait for the hardware drivers to be loaded before continuing. You can also click
Skip obtaining driver software from Windows Update to speed up the driver installation
process.
4. Place the hardware between the Peripheral and Central device. Now you're ready to set up the
software.
—
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Figure 1 System overview
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Install nRF Sniffer

If you haven’t downgraded your SEGGER J-Link to v6.16c, see “nRF Sniffer occasionally works and appears
unstable.” on page 17 for instructions on how to do it.

1. For Windows - Go to Help > About Wireshark.

File Edit View Go Capture Analyze Statistics Telephony Wireless Tools | Help

Am @ LEREQe==0 8 = |=|Q( Ccontes F1
- Manual v
[i |App|'-r' a display filter ... <Ctrl-/> anual pages
M ebsite
FAQ's
Welcome to Wireshark
A Ask (QzA)
Capture Downloads
...using this filter: [ |Enteracapture filter ... M ik
Sample Captures
VirtualBox Host-Only Network |__
Local Area Connection™® 15 __ Check for Updates...
Wireless Metwork Connection __

Local Area Connection |I_ About Wireshark
Sniffer COM199

2. Click on the Folders tab.

Click on the location for Extcap path.

4. Find and copy the nrf_sniffer_<version>_<hash> ZIP file to the folder associated with “Extcap
path”.

w

About Wireshark

Wireshark | Authors  Folders | Plugins | Keyboard Shortcuts | License |

Name Location Typical Files

‘File" dislogs CilUsenmmmmni . ferBLE\sniffer 2 0 0} capture files

Temp Cilsersn. . MeeiApcDataliocal\Temp  untitied capture files
Personal configuration  C: s i ta\Roaming\Wireshark) difiters, preferances, athers, ...
Global configuration  C;\Program Files\Wireshark diiters, preferences, manuf; ...
System Ci\Program Files\Wireshark ethers, pnets

Program Ci\Program Filles\Wireshark program files

PersonalPlugns G \sms e i 20 ing\Wiresharklplugns  dissector plugins
" Exteap path Gi\Program Files \Wireshark\extcap Extcap Pluging search path |
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5. Unzip the ZIP's extcap content to the Wireshark Extcap path found in "About Wireshark” (shown
here as C:\Program Files\Wireshark\extcap).

| . = Computer = QSDisk (C:) = Program Files - Wireshark - extcap -

it wview Toolz Help

- Indude in library - Share with - Burn  Mew folder

MName “ Date modified Type Size
. nrf_sniffer_2.0.0-beta-1_51296aa 12/1/2017 12:52 FM File folder
. SnifferaPI 11232017 3:11PM File folder
nrf_sniffer.bat 10/6/2017 2:28 PM Windows Batch File 1KB
2 nrf_sniffer.py Python File 20 KB

6. Verify that python is callable from the command line.

C:>python --version
Python 2.7.x

uy,n

7. For OS X and Linux - Verify that the nrf_sniffer.py file has the “x” permission. If the “x” permission
is missing add it using chmod +x nrf_sniffer.py.
8. Close Wireshark.
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Install firmware with SEGGER J-Link.

1. Locate the J-Link software.
« Windows - Use the jlink.exe program, usually in C:\Program Files (x86)\SEGGER\.
+ OS X and Linux - Use the jlinkexe program.
2. Remove all hardware attached to the USB. Plug in one of the hardware boards and wait for the
drivers to install.
3. Openacommand window.
4. Inthe command window, type jlink.exe (for Windows) or jlinkexe (for OS X and Linux) and hit
Enter to run the program.
5. Erase the contents by performing the following steps. Press Enter after each command.
a. Type erase.
b. Depending on the board you are using, type nRF51422_XXAC (for the nRF 51DK and
Dongle) or nRF52832_XXAA (for the nRF52 DK).
c. Type s to specify the SWD interface.
. For Speed, type 1000.
e. Type loadfile then <Path to Wireshark>\extcap\nrf_sniffer_<ver-
sion>_<hash>\hex\sniffer_<board name>_<hash>.hex
f. Type rto reset the board.
g. Type g to run the board firmware.

[oR

EEE _ 5] |
Connecting to J-Link via USB...0.K.

Firmware: J-Link OB-SAM3U128-U2-MNordicSemi compiled Jun 9 2817 14:57:23

Hardware version: U1.88

S/N: 681384097

UTref = 3.3880

Type "connect' to establish a target connection, *?' for help
J-Link>erase
Target connection not established yet but regquired for command.
Please specify device ~ core. {Default>: NRF51422_ XHAA
Type '7' for selection dialog
Device >nRF51422 HXAM
Please specity target interface:
J> JIAG (Default>
8> SuUD
TIF>S
Specify target interface speed [kHzl. {Default>: 4888 kH=
Speed>108H
Device "MRF51422_HXAA" selected.

Connecting to target via SUWD

Found SW-DP with ID BxBBB11477

Bcanning APz, stopping at first AHB-AP found.

APLA] IDR: BxB477@0B21 (AHB-AP>

AHB-AP ROM: BxFAAARAAA (Base addr. of first ROM tahle)

CPUID reg: Bx418CC2AA. Implementer code: Bx41 C(ARM>

Found Cortex—M@ rBpB,. Little endian.

FPUnit: 4 code (BP> ots and B literal slots

CoreSight components:

ROMIh1[A]1 P FRAAAAAR

ROMIb1[B1[@]1: EAAFFAAA. : B1@518AD,. PID: BBABB471 ROM Table
ROMIb1[11 @ ERAFFAAR

ROMTbh1[11[6]1: EAAAEAAA. : BiASEAAD. : HAABBAAS SCS
ROMTb1[11[1]1: EAAA1AAA. : BiASEAAD. : BBBBEBBA DUT
ROMTbh1[11[2]1: EAGAZE0H. : BiASEAAD. : BBBEEBBE FPB
ROMTb1[B1[1]1: FAAAZE68H. : B1@5984D. : BABBB?A3 777
Cortex—MBA identified.

Erasing device (nRF51422 xxAA>...

J-Link: Flash download: Total time needed: 5.58%9s (Prepare: B.Bﬁisé gompare: 8.8

"C:wProgram Files\Wireshark\extcapsnrf_sniffer 2.8.8-heta-1_2455
665%hexssnitfer _pcalWWZy_24bhbbh . hex'
Down loading file LC:SNProgram FilesSMiresharkwextcapsnrf_sniffer_2.@.8-heta—-1_245
L665~hex sniffer_pcal@B28_2455665.hex].
J-Link: Flash download: Flash programmii performed for 1 range (14336 bytes)
J-Link: Flaszh download: Total time needed: B.42%9s (Prepare: B.8%93s. Compare: 8.8

B8z, Erase: B.888s, Program: B.278s, Uerify: B.881s, Restore: B.847s)
0.K.

Rezet delay: B ms

Reset type NORMAL: Resets core & peripherals via SYSRESETREQ & UECTRESET hit.
Setting AIRCR.SYSRESETREQ

J—L@nk)g

Figure 2 J-Link erase
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Verify that Jlink emulator firmware is correct version

1. Locate the J-Link software version that is listed in “Required software” on page 2.

2. Only one of the supported hardware should be plugged into the PC.
3. Windows - Use the jlinkConfig.exe program.

Linux and OS X : skip the rest of the steps in this section and follow the steps listed in the Trou-

bleshooting section “Downgrade the J-Link emulator version on the hardware”.

4. The"“Host Firmware” and the “Emulator Firmware” dates displayed in jlinkConfig.exe should be

identical.

1o/
Refresh rate: | Naormal =
Emulators connected via USB: =
er | Product | Mickname | SH | LISE |dentification ﬂHost Firmweare | Emulator Firmware \l
¥ J-Link OB-5AM3U128 2-NardicSem ... BE230117 SN EB2310117 017 Jun 91457 2017 Jun 9 14:57
Kl I+
X Select all I Select nonel
Emulators connected via TCP/P:
| i | Product | Mickname | SH | IP Address | MALC Address | Host Firmware | Emulator Firn

5. If the“Host Firmware” and “Emulator Firmware” dates are not identical, follow the steps listed in
the Troubleshooting section “Downgrade the J-Link emulator version on the hardware”.
6. Verify that the Jlink emulator firmware has been downgraded by following steps 1-3 in this

section.

Page 7



NORDIC

> SEMICONDUCTOR nRF Sniffer User Guide v2.1

Finalize the set up

1. Verify that the Sniffer firmware is running correctly by checking that LED1 toggles each time a
packet is received. At least one device must be advertising for the Sniffer to detect the
advertisements.

2. Open Wireshark. You should see “nRF Sniffer on xxxxx" as one of the interfaces.

3. Click View>Interface Toolbars>nRF Sniffer to enable the Sniffer interface.

| [ The Wireshark Network Analyzer
File Edit | View Go Capture Analyze Statistics Telephony Wireless Tools
A4 m v Main Toolbar = = |@ ¢

- v Filter Toolbar
: Apply &

Wireless Toolbar

eraoe Interface Toolbars

v Status Bar

Full Screen Fii

v Packet List
v Packet Details

4. Click on the board to select it and then click the Wireshark icon to start capturing packets.

[ The Wireshark Network Analyzer
File Edit View Go Capture Analyze Statistics Telephony Wireless Tools Help

Adm 0@ )JERE(] =0 4= =aQ
[' |App|'-r' a display filter ... <Ctrl-/>

Interface ICOMQG LI Device IAII advertising devices LI Passkey [ OOB key I

Welcome to Wireshark

Capture

...using this filter: [ | Enter a capture filter ...

VirtualBox Host-Only Metwork __nn/
Local Area Connection™ 15

Wireless Network Connection
ocal Area Connection

Sniffer COM36

Extcap interface:
nrf_sniffer.bat
Mo capture filter

Figure 3 Initial view - successful installation
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3 Using the Sniffer

The Wireshark capture screen is displayed when Wireshark is first launched. It includes the Wireshark
interface for managing packets that are captured, the nRF Sniffer toolbar, and the hardware interfaces
connected to the nRF Sniffer.

To make the nRF Sniffer toolbar visible, click View>Interface Toolbars>nRF Sniffer.
There are two ways to start sniffing:
« Double click on the hardware interface (nRF Sniffer COM54 in Figure 4).

« Select the hardware interface by clicking on it and then click the Wireshark icon on the top
left to start sniffing.

The Wireshark Network Analyzer - ‘j_nlll
Edt View Go Capture Analyze s Wreless Tools Help
Capturepackets | [fjm A @A ERE(R - =0 4L S [=laaan
[ W Laoply 2 dispiay fite t MMIL

nRFSni‘HerToolbar[ Interface [cCOMS4 ¥ Device [Al advertsng devices | Passkey /OOBkey [ Adv Hop [37,38,3 rep Defauits Log

Welcome to Wireshark
Capture

using this fiter: [\ [Ente

Virtualiox Host-Only Network ___
Local Area Connection™ 15

User's Guide - Wiki - Questions and Answers © Mailing Lists
You are running Wireshark 2.5.0-1595-gfa2643ac (v2.5.0rc0-1595-gfa2648ac). You receive automatic updates.

| 7 Ready toload or capture || Mo Packets || Profie: Defaut

Figure 4 Wireshark capture screen

Once the Sniffer is running, it reports advertisements and lists nearby devices in the Device List. The Sniffer
may not pick up all connect requests and will not always pick up on a connection. In such cases, you need to

reconnect and try sniffing again. If you aren’t seeing any activity in your Wireshark console, see Section 6
“Troubleshooting” on page 17.

The Sniffer has two modes of operation:

1. Listens on all advertising channels to pick up as many packets as possible from as many devices as
possible. This is the default mode.

2. Follows one particular device and tries to catch all packets sent to or from this particular device.
This mode will catch all:

+ Advertisements and Scan Responses sent from the device
« Scan Requests and Connect Requests sent to the device
« Packets in the Connection sent between the two devices in the Connection
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3.1 Sniffer commands

The software interface has several commands to for controlling the Sniffer. Below you will find a list of
commands and their description, along with some examples.

/(% Capturing from nRF Sniffer COM129 = Ellﬂ
Fle Edit View Go Capture Analyze Statistics Telephony Wireless Tools Help
(AW e RE[Re==F sE=Eaaan
[. |App\'-;adispla'-,‘ filter ... <Ctrl-f> Expression ‘ +
Interface |COM129 [~ | Deviee | 87 B e2:fdib5:68:6e:7d rand | Passkey /0B key |279045] =3 AdvHop [37,38,39 | Defaults | Log
. - Advertising ho | Access the online [
Hardware interface J Device list J Passkey and OOB key J 8 hop
sequence User Guide
Resets the user interface
clears log file
Log file per

hardware interface

Figure 5 Sniffer interface

All advertising devices

Lists nearby devices. If this command is used while sniffing a device, it will stop sniffing that device. This
means if the device is in a connection, the sniffer will lose that connection. To enable this option, click the
Device list drop-down and select All advertising devices.

Passkey

Your device asks you to provide your passkey. Type the 6 digit passkey in the passkey text field from
Wireshark, followed by Enter. Then enter the passkey into the device. Passkey entry utilizes Just Works
pairing, which is described in detail in “Just Works - sniffing an encrypted connection” on page 15.

Out of band key exchange (OOB)

You are asked to provide the 16 byte Out-of-band (OOB) key in hexadecimal (starting with 0x, big endian
format). This must be carried out before the device enters encryption. If the entered key is shorter than 16
bytes, it will be padded with zeros in front. OOB entry uses Out of Band pairing, which is described in detail
in “Sniffing a connection between devices that are already paired” on page 16.

Advertising hop sequence
Change the order in which the Sniffer switches advertising channels when following a device. Define the
order with comma separated channel numbers. For example: 37,38,39. Press Enter when done.

This will sniff waiting for a packet on channel 37. After it receives a packet on channel 37 it will transition to
sniffing on channel 38. When it receives a packet on channel 38, it will transition to sniffing on channel 39.
When it receives a packet on channel 39, it will start sniffing on channel 37, and repeats the operation.
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RSSI filter

Applies an RSSI filter on the packets being received. Only packets that match the filter are displayed. To set
the capture filter in the Capture screen in Wireshark use the keyword "rssi"

Example: rssi > -70. This will only display packets that have an RSSI greater than -70 dBm.

File Edit View Go Capture Analyze Statistics Telephony Wireless Tools Help
dm J@ | LERERe==F 0 =< (= |aqa
[il Start capturing packets [t/

Interface ICOMIZQ LI Device IAII advertising devices LI Passkey [ OOE key I

Welcome to Wireshark
Capture
..using this filter: [ |rssi>=—?0|

VirtualBox Host-Only Network
Local Area Connection™ 15

Wireless Network Connection
Local Area Connection

(@) nRF sniffer COM129 -

Figure 6 RSS filter
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Capturing from multiple hardware interfaces/boards

Select all hardware interfaces in the Capture Screen in Wireshark and click Start Capturing Packets.

® [ ] M The Wireshark Network Analyzer
A = .. X |G == = B Q B
|| || Zlart capturing packets| .., = -
Interface | ev/cu.usomodem, [ Device | All advertising devices [ Passkey | OB key el > 280 _telp | |_oe
Welcome to Wireshark
Capture
..using this filter: ([ [Enter a capture filter ... ~| | Allinterfaces shown +

Ethernet: en0

FireWire: fw0

Thunderbolt Bridge: bridge0

Wi-Fi: eml A
Thunderbolt 1: en2

p2p0
Loopback: lo0
@ nRF Sniffer: /devjcu.usbmodemFA13121
@ nRF Sniffer: /devjcu.usbmodemFA13131
@

nRF Sniffer: /devjcu.usbmodemFA1331

@ nRF Sniffer: /devjcu.usbmodemFA1341
@ nRF Sniffer: /devjcu.usbserial-DNOOCSXO0

@ Alenn camnate canboeas clean

Figure 7 Select multiple hardware interfaces

Interface ID

Interface Identifier used by Wireshark to identify the capture interfaces (frame.interface_id)

Board

Hardware identifier for the board running the nRF Sniffer firmware (nordic_ble.board_id)

@ (] £ Capturing from 6 interfaces
w4 © RE Qe EFTEIZ = QQQF
“ | Apply a display filter ... <38/> ~| Expression... +
Interface | joev/cu.uson [ Device | All advertising devices Passkey [ OOB key Adv Hop  37,38,39 Help Defaults Log
No. Time Source Destination Length RSSI (dBm) channel Protocol Board Interface id '
1070 3.335914 €1:3:15:b5:86:d8 Broadcast 48 -48 37 LE LL 50 4
1071 3.336003 :f3:15:b5:86: Broadcast 48 -68 37 LE LL 84 [¢]
1072 3.337388 Broadcast 63 -65 38 LE LL 123 ok
1073 3.338520 Broadcast 48 -62 38 LE LL 84 [¢]
1074 3.338525 Broadcast 63 -68 39 LE LL 123 1k
1075 3.340639 Broadcast 48 -59 39 LE LL 84 [¢]
1076 3.341679 H :b5:86: Broadcast 48 -50 37 LE LL 123 ok
1077 3.342309 €1:f3:15:b5:86:d8 Broadcast 48 -68 37 LE LL 84 [¢]
1078 3.344500 €1:f3:15:b5:86:d8 Broadcast 48 -62 3R LELL R4 4]

Figure 8 Data capture from multiple hardware interfaces
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4 Using Wireshark

All BLE packets detected by the Sniffer are passed to Wireshark where they are wrapped in a header
containing useful meta-information not present in the BLE packet itself. Wireshark dissects the packets and
separates the actual packet from the meta-information.

Packet browsing

When a packet is selected in the Packet List, the Details pane shows the breakdown of that packet. The bytes
of the packet are shown in the Bytes pane. Click a value in Details to highlight it among the bytes, or click on
the bytes to highlight it in the Details.

4 Capturing from \\\pipe\wireshark_nordic_ble 103 (SV nk-
File Edit View Go Capture Analyze Statistics Telephonx Tools Internals Help

oG 4m I BEXZ A¢e*dTLIEE Qaal @&B®M

Filtering —[ Filter: [Mle B Expression... Clear Apply Save
No. Time Source SN NESN event counter  RSSI (dBm)

( (O T R N VSV Iv] £l —vo
8346 173.923743000 40:34:b0:cf:93:4f -46

8347 173.925761000 9:01:14:e3:d9:a4 -68

8348 174.087206000 sY -60

8349 174.114612000 sY -67

8350 174.117430000 40:34:b0:cf:93:4F =77

8351 174.123131000 Master 0 0 0x0000 -47

8352 174.129652000 Slave 0 il 0x0000 -67

PACKET LIST < 8353 174.144080000 Master hlj 1 0x0001 -47
8354 174.146607000 Slave 1 0 0x0001 -64

8355 174.174747000 Master 0 0 0x0002 -49

8356 174.176198000 sSlave 0 f: 0x0002 -67

8357 174.204135000 Master b I 1 0x0003 -47

8358 174.205537000 Slave 1 0 0x0003 -64

8359 174.234357000 Master 0 0 0x0004 -46

8360 174.236465000 Slave 0 1 0x0004 -70

8361 174.264316000 Master 1 i B 0x0005 -49

7 i

60 bytes captured (480 bits) on interface €

& Nordic BLE sniffer meta
uart packet counter: 970233
flags: Ox01

8

encrypted: No
direction: Slave -> Master
CRC: OK

Extra packet _| ey Eels
information | = .... ... 1
channel: 3

RSSI (dBm): -77
delta time (us end to start): 153
§ delta time (us start to start): 233
‘= Bluetooth Low Energy
Access Address: O0x8e89bed6
packet Header
PACKET DETAILS < Init Address: 40:34:b0:cf:93:4f (40:34:b0:cf:93:4f)
Advertising Address: f9:01:14:e3:d9:a4 (f9:01:14:e3:d9:a4)
£ Connection Request
Connection Access Address: Oxaf9a9bde
CRC Init: 0xc75ch2
BLE packet — window size (ms): 3.75
window offset (ms): 22.5
Latency: 0
Timeout (ms): 720
Channel map: ffffffffif
...0 1010 = Hop interval: 10
101. .... = sleep clock Accuracy: 31 ppm to 50 ppm (5)
CRC: 0x3f22c1

u

Packet info as: 0000 “be ef 06 £9 cd 0c 00 34 01 26 4d 00 00 99 00 00
. 0010 00 d6 be 89 8e c5 22 4F 93 cF b0 34 40 ad d9 e3
PACKET BYTES |- hexadecimal (left) —|gp20 14 01 f9 de 9b 9a af b2 5c ¢7 03 12 00 IEEY 00

- ASCII (right) 0030 00 48 00 ff ff ff ff 1f aa 3f 22 a1

Wireshark filter for
connection interval —@ M] Interval (ms) (btle.connect.interval), 2 bytes
btle.connect.interval

Figure 9 Wireshark interface
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4.1 Display filtering

Display filters allow you to display a chosen packet subset. Most filters are based on the values of the
packets, such as length or access address. The filter expressions use Boolean operators (&& || ==!=1). Some
examples are given in Table 1.

Display filter Description

btle.length =0 Displays only packets where the length field of the BLE packet is not
zero, meaning it hides empty data packets.

btle.advertising_address Displays only packets that have an advertising address (advertising
packets).

btle A protocol filter that displays all Bluetooth low energy packets.

btatt, btsmp, btl2cap Protocol filters for ATT, SMP, and L2CAP packets respectively.

Table 1 Display filtering

4.1.1 Wireshark Tips

More information can be found in the documentation on Wireshark’s website.

« For help with constructing filters, click Expression.
« Any field in the Packet Details pane can be made into a column by right clicking the value,
and click Apply as column.

L v msr e s myae W m AT e Wi naag o My s
= Nordic BLE sniffer meta
board: 19
uart packet counter: 55080
flags: Ox01
vv.. 0., = encrypted: No
= direction: slave -> Master
= CRC: OK
channel: 38
RSSI (dem):
delta time Expand All
delta time Collapse All
Bluetooth Low

Expand Subtrees

Apply as Column

Apply as Filter 4
Prepare a Filter 4
Colorize with Filter 4

Figt_u:e 10 Apply as column

+ You can apply a value as a filter. This can be useful if you want to see only operations
affecting a particular handle, for example. To filter packets either having a specific value for
some field, do as follows:

« Right click the value in the packet details, click Apply as Filter, and click Selected.
- Saving a set of captured packets is useful if they need to be looked at later. To save a set of
captured packets do the following:
« Click the Stop button to quit capturing packets.
« Click File and select Save as to save all packets. Click File and select Export Specified
Packets to save a selection of packets.
« The Restart button is used to restart a capture and to clear the packet list.
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5 Common sniffing actions

Sniffing advertisements from all nearby devices

To see advertisements from all nearby devices:

1. Start the nRF Sniffer.
2. Ensure”All advertising devices” is selected in the Device drop-down.

Sniffing advertisement packets involving a single slave device

To see advertisement packets, scan requests, and scan responses to and from a single device:

1. Start the Sniffer if not already running.
2. Inthe Sniffer, choose the device from the Device drop-down list.

Sniffing a connection involving a single slave device

To sniff a connection between a specific Peripheral device and a Central:

1. Start the Sniffer if not already running.
2. Inthe Sniffer, choose the device from the Device drop-down list.
3. Connect the Central to the Peripheral.

Just Works - sniffing an encrypted connection

To sniff a connection encrypted with Just Works:

1. Start the Sniffer if not already running.

2. Inthe Sniffer, choose the device from the Device drop-down list.

3. Initiate pairing between the devices if it does not happen automatically.The Sniffer will
automatically decrypt encrypted packets.
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Sniffing a connection between devices that are already paired

The Sniffer needs to have sniffed the pairing procedure if the devices are already paired. If the sniffer board
is reset, stored pairing information will be lost.

To sniff a connection encrypted with passkey:

—_

Start the Sniffer if not already running.

In the Sniffer, choose the device from the Device drop-down list.

Initiate pairing between the devices if it does not happen automatically. A passkey will be
displayed on either the Central or the Peripheral device.

4. Type the 6 digit passkey from the passkey text field in Wireshark.

5. Press Enter.

6. Enter the passkey into the other device after entering it into the Sniffer.

w N

To sniff a connection encrypted with OOB:

—_

Start the Sniffer if not already running.

2. Inthe Sniffer, choose the device from the Device drop-down list.

3. Enter the OOB key into the Sniffer before the devices initiate pairing.
- Type the OOB key in big-endian, hexadecimal format with a leading "0x"
+ Press Enter.

4. Connect the Central to the Peripheral device.

5. [Initiate pairing between the devices if it does not happen automatically.
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6 Troubleshooting

The nRF sniffer is not listed in the Wireshark interface.

1. See if the hardware has been enumerated on USB and the drivers are loaded.
2. Check that the HEX file for the hardware has been flashed.
3. Reset the hardware by unplugging the hardware, waiting 5 seconds, and plugging it back in.

If it still doesn’t appear, verify the python script located in the extcap folder is able to run.

For Windows:

1. Runnrf_sniffer.bat --extcap-interfaces to listthe interface.

2. If this exits with a python error, verify that python.exe can be run from the command line
c:>python.exe --version, wherethe Python version is the same as Section 1.2 “Required
software” on page 2.

For OS X and Linux:

1. Verify that the execute permission is present for the nrf_sniffer.py file.
el1ls -1 nrf_sniffer.py

2. Ifthe "x" permission is missing:
e chmod +x nrf_sniffer.py

3. Runnrf_sniffer.py --extcap-interfaces to list the interface.

I cannot see the extcap folder in Wireshark.

1. Create the extcap folder as described in “Install nRF Sniffer” on page 4.

nRF Sniffer occasionally works and appears unstable.

Make sure you are using the correct software versions as stated in Section 1.2 “Required software” on
page 2.

Verify that the J-Link emulator version on the hardware is as stated in Section 1.2 “Required software” on
page 2. To verify:

1. Open the JLinkConfig.exe in the install folder of the required J-Link version.
2. The host firmware and the emulator firmware should have the same date.

Upgrade the J-Link emulator version on the hardware.

Download the J-Link software as mentioned in Section 1.2 “Required software” on page 2.
Unplug the hardware, wait 5 seconds.
Plug in the hardware.
For Windows:
+ Run jlink.exe from the folder where the J-Link software was installed.
« A popup appears "A new firmware version is available.....Do you want to upgrade ...?"
+ Click yes.
5. OS X/Linux
« Type*“jlinkexe”. The J-Link firmware updates automatically.

HwnN =
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Downgrade the J-Link emulator version on the hardware.

For Windows:

Ensure only one J-Link is connected to your computer.

Run jlink.exe from the folder where the J-Link version was installed.

In jlink type “exec invalidatefw”.

Click yes when prompted.

In jlink type “exit” to exit jlink.exe.

Run jlink.exe from the folder where the J-Link version was installed (it is necessary to run it a
second time).

Click yes to upgrade your firmware.

8. You have now successfully downgraded the J-Link version on the emulator.

ok wnN =

N

For OS X and Linux:

—_

Ensure only one J-Link is connected to your computer.

Run jlink.exe from the folder where the J-Link version was installed. (Install the older version of
J-Link if required.)

Run jlinkexe.

In jlinkexe type "exec invalidatefw".

In jlinkexe type "exit" to exit the jlinkexe.

Run jlinkexe (this is required to be run for the second time). The J-Link firmware will be updated
automatically to the installed version of J-Link.

N

S

“nRF Sniffer on xxxxx” doesn’t show up as one of the interfaces when | open Wireshark.

1. Click View in the Wireshark toolbar.
2. Select Interface Toolbars then click nRF Sniffer.
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Liability disclaimer

Nordic Semiconductor ASA reserves the right to make changes without further notice to the product to
improve reliability, function or design. Nordic Semiconductor ASA does not assume any liability arising out
of the application or use of any product or circuits described herein.

Life support applications

Nordic Semiconductor’s products are not designed for use in life support appliances, devices, or systems
where malfunction of these products can reasonably be expected to result in personal injury. Nordic
Semiconductor ASA customers using or selling these products for use in such applications do so at their
own risk and agree to fully indemnify Nordic Semiconductor ASA for any damages resulting from such
improper use or sale.

Contact details

For your nearest distributor, please visit http://www.nordicsemi.com.
Information regarding product updates, downloads, and technical support can be accessed through your
My Page account on our homepage.

Main office:  Otto Nielsens veg 12 Mailing address:  Nordic Semiconductor
7052 Trondheim P.O. Box 2336
Norway 7004 Trondheim
Phone: +47 72 89 89 00 Norway

Fax:  +4772898989
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Revision History

Date Version

January 2018 2.1
November 2017 2.0
April 2017 14
March 2017 1.3
July 2014 1.2
April 2014 1.1
December 2013 1.0

Updated content:

« Section 1.2 “Required software” on page 2
«+ Section 2 “Setting up the nRF Sniffer” on page 3

Description

nRF Sniffer updated to work more closely with Wireshark.
Updated software to support the nRF52 DK.

Updated content:
« Removed reference to nRF52 Series in the Section 1.1 “Required hardware”
on page 2

. Section 1.2 “Required software” on page 2
- Section 2 “Setting up the nRF Sniffer” on page 3

Updated content:

« Section 1.1 “Required hardware” on page 2
. Section 1.2 “Required software” on page 2
- Chapter 2 “Setting up the nRF Sniffer” on page 3

Updated content:

Section 1.1 “Required hardware” on page 2
. Section 1.2 “Required software” on page 2
« Chapter 2 “Setting up the nRF Sniffer” on page 3
« Section 2.1 “Running the Sniffer” on page 6

« Chapter 3 “Using the Sniffer” on page 9
« Chapter 4 “Using Wireshark” on page 13

- Section 4.1.1 “Wireshark Tips” on page 14
- Chapter 6 “Troubleshooting” on page 17

Updated firmware, now supports all versions of PCA10000 and PCA10001.

First release.
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